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Trademarks

Microsoft is a U.S. registered trademark of Microsoft
Corporation.

Windows, Windows Vista, Windows XP, Windows 7 and
Windows 8 are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other
countries.

IBM, IBM PC are registered trademarks of International Business
Machines Corp.

ENERGY STAR® and the ENERGY STAR mark are registered
trademarks of the U.S. Environmental Protection Agency.
Other brands and product names herein are trademarks or
registered trademarks of their respective holders.

Copyright

All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language or computer language,
in any form or by any means, electronic, mechanical, magnetic,
optical, chemical, manual, or otherwise, without the prior
written permission of Avision Inc.

Material scanned by this product may be protected by
governmental laws and other regulations, such as copyright
laws, the customer is solely responsible for complying with all
such laws and regulations.

Warranty

The information contained in this document is subject to
change without notice.

Avision makes no warranty of any kind with regard to this
material, including, but not limited to, the implied warranties
of fitness for a particular purpose.
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Avision shall not be liable for errors contained herein or for
incidental or consequential damages in connection with the
furnishing, performance, or use of this material.

FCC Statement:

This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one of the
following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and
receiver.

e Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

e Consult the dealer or an experienced radio/TV technician
for help.

This device complies with Part 15 of the FCC Rules. Operation
is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) this device must accept
any interference received, including interference that may
cause undesired operation.
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C€

European Union Regulatory Notice

Products bearing the CE marking comply with the following EU
Directives:

. Low Voltage Directive 2006/95/EC

. EMC Directive 2004/108/EC

. Restriction of the use of certain hazardous substances
(RoHS) Directive 2011/65/EU

CE compliance of this product is valid if powered with the
correct CE-marked AC adapter provided by Avision.

This product satisfies the Class B limits of EN55022, EN55024,
safety requirements of EN 60950 and ROHS requirements of
EN50581.

*This machine is certified as Class 1 LED product.

Disposal of Waste Equipment by Users in Private Union
|

This symbol on the product or on its packaging indicates that
the product can not be disposed of with your other household
waste. Instead it should be sent to appropriate facilities for
recovery and recycling in an effort to protect human health and
the environment. Fore more information about where you can
drop off your waste equipment for recycling, please contact
your local city office, your household waste disposal service or
the shop where you purchased the product.




User’s Manual

' ' As an ENERGY STAR® Partner, Avision Inc. has
s determined that this product meets the ENERGY
ENERGY STAR STAR guidelines for energy efficiency.

System Requirements

CPU: Intel® Core™ 2 Duo or higher

Memory: 32 bit: 2 GB
64 bit: 4 GB

Optical Drive: DVD-ROM Drive
USB Port: USB port 2.0 (compatible with USB 1.1)

Compatible Microsoft Windows XP(SP3), Windows Vista,
Operating Windows 7, Windows 8.x (32-bit/64-bit)
System:
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1. Introduction

Congratulations on your purchase of this scanner. Avision is
one of the leading companies to make high quality color
image scanner.

Before you install and operate the new scanner, please take
a few minutes to read through this manual. It provides
proper instructions for you to unpack, install, operate and
maintain the scanner.

The following figure indicates the package contents. Please
check all the items against your checklist. If you do not
receive all the items, please contact your authorized local
dealer immediately.

1-1
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1 Scanner Main Unit

2. Software CD/Quick Guide

3. USB Cable

4 Power Adapter & Power Cord

Note:

1. Only use the AC adapter WA-18H12 by APD included in the
machine. Using other AC adapters may damage the
machine and void the warranty.

2. Please unpack the packing carefully, and check the contents
against the checklist. If any items are missing or damaged,
please contact your dealer immediately.

3. To access more service supports, visit www.avision.com to
register your Avision’s product.

1-2
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2. Scanner Installation

2.1 Precaution

= Keep the scanner out of direct sunlight. Direct
exposure to the sun or excessive heat may cause
damage to the unit.

= Do not install the scanner in a humid or dusty place.
= Be sure to use the proper AC power source.

= Place the scanner securely on an even, flat surface.
Tilted or uneven surfaces may cause mechanical or
paper-feeding problems.

m  Retain the scanner box and packing materials for
shipping purposes.

2-1
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2.2 Connecting to Power

Before connecting, make sure the power switch is off.

Plug the small end of the power adaptor into the power jack of
your scanner. Insert the other end to an appropriate power
outlet.

2.3 Turning on the Power

Press the Power button on the front panel, the Power LED
will be lit. To turn off the scanner, press the Power button
for about 3 seconds, the Power LED will be off.

OEKD

2-2
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2.4 Installing the Scanner Driver

NOTE:

1). To ensure your computer can identify the USB scanner,
please install scanner driver first before connecting the
scanner to your computer.

2). The scanner driver contains TWAIN driver. If you are
running Windows XP or later, after the installation of
scanner driver is completed, this scanner allows you to
scan via a TWAIN user interface. Start your TWAIN-
compatible image editing software application to select a
TWAIN.

Place the supplied CD-ROM onto your CD-ROM drive.

The software installation graphic appears. If not, run
“setup.exe”.

Avision |

A vision of your office *

www.avision.com

Smart Tmage

Install Scanner Driver
Install Button Manager
Install Adobe Reader
Install QuickScan

Install Dynamsoft Scan

2-3
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Contents on the installation graphic:

3.

Install Scanner Driver: To communicate with
your scanner, you need to install the scanner driver.

Install Button Manager V2: To use the buttons
on the scanner, you need to install Button Manager
V2. To ensure Button Manager V2 works properly,
please FIRST install scanner driver before installing
Button Manager V2.

Install Adobe Reader: To view the user’s
manuals for the scanner and Button Manager V2,
you need to use Adobe Reader to open and view the
manuals in pdf file format. If you already have
Adobe Reader installed on your computer, you may
disregard this item.

Install Dynamsoft Scan: To scan and detect
barcode, you can install the software application to
have a few tests.

View Manual: Click “View Manual” to view or
print the detailed user manual for the scanner and
Button Manager V2 respectively.

Click Install Scanner Driver to install the scanner driver
and then click Install Button Manager V2 to install the
Button Manager V2 unto your computer.

2.5 Connecting to Computer

1.

Connect the square end of the USB cable to the USB port of
your scanner. Connect the rectangle end to the USB port of
your computer.

2-4
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i. /ﬁj LUER

The computer should detect a new USB device and prompt
a “New Hardware Found” message.

In Windows XP, click the Next button to continue. When
the XP certification screen appears, click Continue
Anyway to complete the installation.

When the Finish dialog is prompted, click the Finish
button.

2-5
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3. Completing Your First
Scan

3.1 Loading Your Paper

Open the document cover then place your original FACE
DOWN on the document glass as shown in Fig. 3-1.

Make sure the top of your original near the document
alignment mark.

Document cover
Document alignment mark
Your original

Document glass

1.
2.
3.
4.

Figure 3-1 Placing the original

3-1
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3.2 Verifying Your Scanner Installation

To verify if your scanner installation is correct, Avision provides
you a useful test program called Avision Capture Tool. With
this tool, you can perform simple scans and view the captured
images. In addition, it helps you complete your scan at a rated
speed.

The following procedure describes how to verify your scanner
installation. If the installation is not correct, please review the
preceding section to check if the cable connection and scanner
driver have been successfully installed.

Before you begin, be sure the scanner is on.

1. Select Start>Programs=>Avision Xxxx Scanner=>Avision
Capture Tool.

The Select Scanner Model dialog box will be displayed.

Select Scanner Model g‘

Diiver Type
TWAIN

Scanner Model
AwiSion w0 ~

~ Cancel

2. Select your driver type and scanner model and click OK.
The following Avision Capture Tool dialog box will be
displayed.

3-2
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5.

Fit Actual
Page Size

BE Avision Capture Tool (TWAIN) - xxxx

File  View Ahout

@Semp ] Hofomst [BMP ¥ [y Scanimege EB L)

| |
' . Save File Path
File Format
Scan
Setup

Choose your desired file format from the File Format drop
down list box. (Default is BMP, other choice includes TIFF,
MTIFF, PDF, MPDF, GIF, and JPEG.) The supported file
formats vary depending on your scanner model.

Type your desired folder name and file name in the File
Path box. (Default is C:\My Scan\Image.)

Note:
If you do not wish to save the scanned image, deselect the

Save button since default is Save Enable. In this case, the
thumbnail view will be disabled. And therefore, after
viewing all the scanned images, only the last one will
remain on the screen.

’fj Setug
Click the Setup button ( f}ij 1J) or choose Setup from the
File menu to prompt the Scanner Properties dialog box.

3-3
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10.

£ Scanner Properties E|

Image | Paper | Setting | Information

[ [Front Auto Color Detestion Binarization Dynamic Thieshald
] Sensiiy
Image —10
:
Selection

Box

Frear Auto Color Detection | Fiescluion (d) 200 Vi)
et Black on'White v
Ll

Ooooo

Sean Source: | Auto Document Feeder v

From the Image Selection Box, choose your desired image
type for your scanned image. (Default is Front B&W) If
you have a duplex scanner, choose Front and Rear to scan
both sides of your document.

Click OK to quit the Scanner Properties dialog box. (To
learn more details about the Scanner Properties dialog box,
please see the subsequent chapter, Using the Scanner
Properties Dialog Box.)

Place your document face down on the document glass or
face up in the auto document feeder.

In the Scan Validation dialog box, click the Scan button

Sran
( o ) or choose Scan from the File menu.

The document will be scanned and displayed in the Scan
Validation screen. After the scanned images have been
displayed, your scanner installation verification is
completed.

3-
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@W o m File Faremt: JFEG Ty Soanimage

Thirty-one cakes, dampened with whiskey, bask on winowsits snd
shates

W are they fort

Frinnds. Wot Sotrasely neihtor fiends! indesd, (b laper share i
Interced for paSOnS m'er Mt maySe GRCR, PRrADS Mt 8t 48
. Beowval. Like the

feetued bere 4 wrter. OF The Ml kedle Gisder wh0 £aTes
Rhwough tam bice B year, O Abner Fadber, e Sriver of Dhe s
‘b b 1o Motibe, wha Eschanges witees wih us weery day as.
4 et In 4 Suet-Choud whaomh. OF Eh yEung Watant, § Calfama

wha spen attiog o
et 0. 188

strangers,
think yes. Alua, the scrapbosks me kees of inank:you's 01 Whits

Bormes, the ke o7

of
Insade out. Weee broke. That rather desresses. me, bt my friend

.2 nowt of
‘Ehucoey-flvvtend Ws atroag). Tha felt we Svide betwees 8 pair of
Jeiy Glanues. e Both gule swed ot the rospect of ddnking

f—— by 4nd by e begin 50 #eg, the beo of 3 siaging
1ot ]

Dk, ue |

€3 Sann: Ty what | mean 1o be, & tap dander it the Mmavies. My

fancing shadge ruicks on the wally; cur voice rck the cinmant
o tiekting us.

Fit Page View

Thumbnail View

11. You can view the scanned image in Fit Page (‘Q‘) or
Actual Size (100%) button (D ) from the Viewing toolbars
at the right side.

12. Click the Close box or Quit from the File menu to exit the
Scan Validation Tool.
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3.3

—{rimage | Paper | Setting | Information

[0 [Front Auts Coboe Detection | Binsization: D T ook -
o e — o »
[ [FontBi | f Ui | E—

A Glance of the Scanner Properties Dialog Box

& Scanner Properties [%]

— = ] o) Co )

[ [Hes ivbe Cokn Detecton | Presshsion (e an «|[ ..
[ [ Colen ]

[ [Aee Gray | T | p—
O [Res bz ]

o0hw

Ireemil. Elach on 'Wide w

Sran Spane | Aok Diocurent Fesder w

Frolies. Cutom w

1.

Tab Options

Choice: Image, Compression, Color Dropout,
Paper, Multi-Feed Detection, Preview, Options,
Settings, Information.

. Image

Selection Box

Choose your image type and the side of
document you wish to scan. Options vary
based on type of scanner.

3. Brightness Adjust the brightness level from —100 to +100.

4. Contrast Adjust the contrast level from —100 to +100.

5. Resolution Determine the quality of the scanned image.
The industry standard is 200 dpi.

6. Invert Reverse the color of your scanned image.

7. Scan Source |Choice: Auto Document Feeder, Flatbed,
Flatbed (Book), Automatic (varies due to
different scanner model)

8. Defaults Reset all values on the tabs to the factory

default settings.

3-6
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4. Using the Scanner
Properties Dialog Box

The Scanner Properties dialog box allows you to configure the
scanner’s settings. It consists of several tabbed windows each
of which will be described in this chapter.

Note: In this chapter, all options are available based on a
duplex (double-side) scanner. If you have purchased a simplex
(single-side) scanner, all options are available for single sided
only.

& Scanner Properties &‘

Image ‘Paper Setting | Infarmation

| Binarizatior:
O Sensitivity:
D

| Resolution (dpi) |ZDU "l:]
0
0
O

Irivert: | Elack on'white v |

Scan Source: ‘Auto Document Feader b |

Profiles ] ‘ Custam v |

The Scanner Properties dialog box

4-1
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4.1 Buttons on the Scanner Properties Dialog Box

& Scanner Pro perties

Image: ‘Paper Setting | Infarmation

3]

O

tont Auto Color Detection

Tont Caolor

™

ront Giray

Tont B

gar Autn Color Detection
ear Color

ear Gray

W - =
| D] [T [P T[] [
o
&
E}
@
2
3
g

ear Biw

Bimarizatior:

Sengitivity:

Rezolution (dpil:

Ireeett:

2 |Auto Document Feeder

Profiles..

| Custam

The buttons on the Scanner Properties dialog box

Buttons | Description

Defaults | Click the Defaults button, the factory default
settings will be shown on each tab.

Cancel Click the Cancel button to leave the Scanner
Properties dialog box.
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The following table shows the default settings :

Tab name

Default settings

Image

Image : Front B&W

Binarization : Dynamic Threshold
Resolution : 200 dpi

Invert : Blank on White

Scan Source : Auto Document Feeder
Threshold : None

Brightness : None

Contrast : None

Compression

None

Color Dropout

None

Paper

Cropping : Automatic
Deskew : Yes
Orientation : Portrait
OverScan : 0.00

Note: The availability of this option
varies due to scanner model.

Unit : Inch
Multi-Feed None
Detection
Preview None
Options Rotation Degrees : None
Blank Page Removal : None
Edge Fill : White > 0 mm
Image Control Option : None
Setting Enable Energy Saver : Enable, 15
minutes after last scan action
Show Scanning Progress : Yes
Show Warning Message : Yes
Save Settings after Closing : Yes
Imprinter Digital Imprinter

4-3
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4.2

Showing or Hiding Tabs

The [Scanner Properties] dialog box is displayed in default
with three basic tabs - Image, Paper, and Information. To
show more tabs, click the [Scanner Properties] icon to access
more scan settings.

To show more tabs,

1.

Click the [Scanner Properties] icon ) on the upper
left corner, and choose [Tab] to show available tab names.
The available tabs include Compression, Color Drop out,
Preview, Rotation, Separation, Multi-Feed, Options,
Settings, and Imprinter. (Note: the options vary based on
scanner model.)

Choose the tab you want to display. The selected tab will
be shown with a check mark and then displayed in the
[Scanner Properties] dialog box.

To access the settings, click the selected tab on the top of
the [Scanner Properties] dialog box. The page of the
selected tab will be displayed.

To hide a tab window,

1.

Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tabs] to show available tab
names.

Choose the tab you want to hide. Then, the selected tab
will be hided in the [Scanner Properties] dialog box.

Note: The [Image], [Paper], and [Information] tab can
not be hided since they preprogrammed to be displayed by
default.

4-4
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& Scanner Properties E

BT Covvein |
Color Dropout
Preview

Rotation

Front Color Separation
[ [Front Gray v Optious
o Betting 0% 1
[ [FrontBW Tnprinter A
T 0% | L
[ [Resr Auto Color Detection . i
Resolution (dpi):
=
O [Bekon e ]
=

|

Soan Sovrce: ‘Autn Diocument Feeder vl
[ Pufiles. | |Custom |
Calor Matching: ‘Ducumem Vl

4-5
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4.3 The Image Tab

The Image tab allows you to choose the front side and (or) the
rear side of your document, the type of image, and to set
several basic scan settings. Note that except for the resolution,
you can set individual scan settings for the front side and the
rear side. For example, all settings in the Image tab,
Compression tab, Color Dropout tab can be set individually for
the front and the rear side. However, the settings in the Paper
tab, the Option tab, and the Setting tab have to be set the
same for the front and rear side.

£ Scanner Properties El
Image | Paper | Satting | Information

[ [Front Auta Color Detection Binarizatior: Dynamic Threshold

Tont Color Sengitivi:

™

Tont Gray

Tont B

=

ear Auto Color Detection Resolution (dpi} 200 ~ E

ear Color
Irveert; Black on White ~
ear Gray

ear B/

] [ |
3| [T [T [3 ol [3] [
o
g
E]
s
£
3
B

2 | Auto Document Feeder ~

Profiles.. Custom -

The Image tab dialog box
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4.3.1 The Image Selection Box

ot Auto Color Detection

B0

O

rort Color
nont Gray
Tont B

OO

Fiear Auto Color Detection
ear Color

]

ear Gray
ear B

0o

The Image Selection box includes the
image type and document side option. If
you wish to scan both the front side and
the rear side of your color document, you
can check both Front Color and Rear Color

at the same time.
based on type of scanner.

Note the options vary

Example 1 : Scanning a two-sided color document, both

sides in color

[ [Front Auto Color Detection
O
%

O earso o oion )
T —
] T —

Side/Image
Selection

Rear

4-7
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Example 2 : Scanning a two-sided color document, one

in B&W, the other |n color _

[ [Front Auto Color Detection

I

=

tant Color
O [Froet Gray
[ [Front Bt

Rear futo Color Detection
ear Color

eal Gray

OO0

ear BEW

Side/Image
Selection

Front Rear

Image Type

Description

Color

Choose Color if you wish to scan a color
image for your original in color.

Gray

Choose Gray image if your original contains
actual shades of gray.

B&W

Choose B&W if your original contains only
text, pencil or ink sketch.

B&W

Gray

4-8
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Front/Rear Auto Color Detection:

Click to automatically detect and scan the front or the rear
page of your color document in color image mode. If your
document is in colors, the scanner will automatically scan the
document into a color image. If your document is non-color,
you can choose the output to be either B&W or Gray from the
Non-Color Selection option. This option is useful when you
have a mixture of color and non-color document.

Note: If you choose Front Rear Auto Color Detection, you can
not specify the image mode of your rear page and vice versas.

Sensitivity of Auto Color Detection

If your documents contain primarily B&W text and small
amount of light or pale colors and you do not wish them to be
recognized as color image to save the file size, you can
increase the sensitivity value by moving the bar to the right to
let these images to be detected as B&W. The value ranges from
1 to 100. The default is 37.

Standard 1EEE 802.11 b/g/n standards compliant

Wireless LAN 1T1R Mode

Frequency Range | 2.400 ~ 2.4835GHz ( subject to local regulations)

802.11n: 20MHZ/40MHz

UsA, Canada (FcC):11 channels

Number of (2.412GHz~2.462GHz)

Selectable s02.1

Channels Europe (CE): 13 channels (2.412GHz~2.472GHz)

1/g
Japan (reLeC): 14 channels
(2.412GHz~2.4835GHz)

802.11n: up to 150Mbps
Data Rate 802.11b: 1, 2, 5,5, 11Mbps.
802.11g: 6, 9, 12, 18, 24, 36, 48, 54Mbps

11 HT40 MCS7 : +13 dBm

Transmit
11 OFDM: +15 dBm
Power(EIRP)

11b CCK: +18 dBm

Security WEP 64/128, TKIP, WPA, WPA2 mixed,802.1x and 802.111

Original

4-9
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Standard

1EEE 802.11 b/g/n standards compliant

Wireless LAN

1T1R Mode

Frequency Range

2.400 ~ 2.4835GHz ( subject to local regulations)

802.11n: 20MHz/40MHz

USA,  Canada  (FCO)11  channels
Number of (2.412GHz~2.462GH2)
Selectable 2.1
Channels Lbjg: | EUTOPe (CE): 13 channels (2.412GHz~2.472GHz)
Japan (TELEC): 14 channels
(2.4126Hz~2.4835GHz)
802.11n: up to 150Mbps
Data Rate 802.11b: 1,2, 5,5, 11Mbps
802.119: 6,9, 12, 18, 24, 36, 48, S4Mbps
— 11n HT40 MCS7 : +13 dBm
Transmit
11g OFDM: +15 dBm
Power(EIRP)
115 CCK: +18 dBm
Security WEP 64/128, TKIP, WPA, WPA2 mixed,802.1x and 802.111

Standard 1EEE 802.11 b/g/n standards compliant
Wireless LAN 1TIR Mode
Frequency Range | 2.400 ~ 2.4835GHz ( subject to local regulations)
802.11n: 20MHz/40MHz
USA, Canada (FCC):11 channels
Number of (2.412GHz~2.462GHz)
Selectable 802.1
Channels by | EUTOPe (CE): 13 channels (24126Hz+2.472GHz)
Japan (TELEC): 14 channels
(2.412GHz~2.4835GHz)
802.11n: up to 150Mbps -
Data Rate 802.11b: 1, 2, 5,5, 11Mbps
802.11g: 6, 9, 12, 18, 24, 36, 48, 54Mbps.
11n HT40 MCS7 : +13 dBm
Transmit
Power(EIRP)
116 CCK: +18 dBm
Security WEP 64/128, TKIP, WPA, WPA2 mixed,802.1x and 802.11i

Sensitivity: 1 Sensitivity: 100
(The image is recognized as | (The image is recognized as
a color one) a black and white one)

4-10
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4.3.2 Other Image Options

Binarization This is the process of converting a
grayscale or color image to a bi-tonal
image. There are several different
methods of performing this conversion.
Options: Dynamic Threshold, Fixed
Processing, Halftone 1—5, Error
Diffusion.

Dynamic Threshold: Selecting
Dynamic Threshold allows the scanner
to dynamically evaluate each document
to determine the optimal threshold value
to produce the highest quality image.
This is used to scan mixed document
containing faint text, shaded background,
or color background with a single setting.
If Dynamic Threshold is selected,
Threshold, Brightness, and Contrast are
not available.

Sensitivity of Dynamic Threshold
Occasionally your scanned image may
contain small dots or speckles. To remove
these spots, increase the sensitivity value
by moving the bar to the right. The value
ranges from 1 to 30. The default is 20.
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Fixed Processing: Used for black-and-
white and other high contrast documents. A
single level is set to determine the black-
and-white transition. The threshold is
programmable over the entire density
range. Fixed Processing sets Contrast to
0. If Fixed Processing is selected,
Contrast is not available.

Halftone: In addition to the black and
white display, Halftone can present a
somehow gray shade of image by using
different size of dots. Halftone image looks
like the picture we have seen in the
newspaper. Options include Halftone 1,
Halftone 2, Halftone 3, Halftone 4,
Halftone 5.

Error Diffusion: Error Diffusion is a type
of Halftone. Error Diffusion gives good
image texture and makes text in images
more readable than Halftone.

BROTMOUS

Halftone Image
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F. Michelang
Architecture
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Error Diffusion Image
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Threshold

Used to convert a grayscale image to a
bi-tonal image. The value ranges from O to
255. A low threshold value produces a
lighter image, and can be used to subdue
backgrounds and subtle, unneeded
information. A high threshold value produces
a darker image, and can be used to help pick
up faint images.

Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to
achieve the desired threshold setting.

4 & 4 4§ A & & s

200 dpi, 200 dpi,
Threshold:50, Threshold:100,
Brightness: O Brightness: O
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Gray

Document Type: Choice: Normal, Photo, Document
Three options of document type are provided when you choose
Gray as the image type for your scanned document. Choice:
Normal, Photo, Document.

. Document: Choose Document if your original contains
pure text or a mixture of text and graphic since it is an
optimal setting for regular business document. When
using Document, only Threshold can be adjusted.

. Photo: Choose Photo if your original contains photo to
reproduce your photo in vivid grayscale image. When
using Photo, no Threshold and Contrast can be adjusted.

. Normal: When using Normal, Threshold, Brightness, and
Contrast can be adjusted.

Threshold: The value ranges from O to 255. The default is
230. A low threshold value produces a lighter image, and can
be used to subdue backgrounds and subtle, unneeded
information. A high threshold value produces a darker image,
and can be used to help pick up faint images. Adjust the
threshold setting by dragging the Threshold sliding bar to the
left or right to achieve the desired threshold setting.
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Normal Photo Document
(Threshold: 230)

Normal Photo o Document
(Threshold: 230)
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Brightness Adjusts the lightness or darkness of an
image. The higher the value, the brighter
the image. Drag the slider to the right or
left to increase or decrease the brightness.
The range is from —100 to +100.

Contrast Adjusts the range between the darkest and
the lightest shades in the image. The
higher the contrast, the bigger the different
grayscale. Drag the slider to the right or
left to increase or decrease the contrast.
The range is from —100 to +100.

Brightness: -50 Brightness: O
(Normal)

Contrast: -50 Contrast: O Contrast: +50
(Normal)
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Resolution A good control of the resolution results a
good detail of an image that scans. The
resolution is measured by dots per inch
(dpi). Normally, the greater the dpi number,
the higher the resolution and the image file
size. Be aware that greater resolution takes
more time to scan, and more disk space for
the scanning image. For your information,
an A4 size color image scanned at 300 dpi at
True Color mode consumes approximately 25
MB of disk space. A higher resolution
(usually means over 600 dpi) is only
recommended when you need to scan a
small area at True Color mode.

Choose a resolution value from the drop
down list. The default value is 200 dpi.
Available resolutions are 75, 100, 150,
200,300, 400 and 600. Or you may choose
your desired value by clicking the box in the
right side of the drop down list and press the
arrow key to select your desired value and
then click the Add button to include it in the
drop down list. Note: The resolution is up to
300 dpi if an imprinter or a MICR reader is
installed or connected to the scanner.

=

- :
Resolution: 75 dpi Resolution: 150 dpi
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Invert

“E am not worthy to have you gnter my

: that is God, I beg all my brothers - those w
& who work manuglly, clerics and lay brothers
args belng humble in all things; nat to glorify
r to become interlorly proud because of good w
sametimeas says er does in them or through tl
ard:  “Do not rejoice--- in the Ract that the de
10 20} Let us be firmly convmced of the fact

Black on White

“I am not worthy t¢ have you enter m

that is God, I beg all my brothers - those v
E who work manually, clerics and lay brothe

rds being humble in all things; not to glority
to becorne Interlorly proud because of gand
sometimes says or does in them or through 4
rd:  “Do not rejoice--- in the fact that the dd
10:20) Let us be firmly convinced of the fa

White on Black

Reverses the brightness and the colors in the
image. The default setting is Black on a White
background. Reverse mode is White on a Black
background. For color images, each pixel will be
changed into its complementary color at the
command of Invert.
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Scan
Source

Choice:

Auto Document Feeder: Used to scan
multiple pages.

Flatbed: Used to scan a single page. For
example, pages from newspaper clipping,
paper with wrinkles or curls.

Flatbed (book): Used to scan several
inside pages from book.

Automatic: Allow the scanner automatically
set its scan source. If Automatic is selected
and there is document in both the auto
document feeder (ADF) and the flatbed, then
the scan source will be automatically set to
ADF. If Automatic is selected and there is
document only in flatbed, then the scan
source will be set to flatbed.

Merge Two Sides into One Image:

If you have a sheet-fed duplex scanner with
front input tray, you can scan an A3 size
document with an innovative method. Thus,
fold your A3 size document into A4, and then
load the paper in the front tray. Choose
Merge Two Sides from the Scan Source
option and then the scanner is able to scan
both sides of your document and merge two
A4 images into one A3 image.

When you select Merge Two Sides into One
Image, the Cropping or Multi-feed function
will be disabled.

Note: This feature must be used with a
carrier sheet. Regarding how to load a
document with a Carrier Sheet, refer to
Section 4.6.2, Other Paper Selection.

Note the options vary based on type of
scanner.
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Select the “Merge Vertically” option to merge
the front side and the rear side of a page into
one image vertically. If the “Merge Vertically”
option has not been selected, the front side and
the rear side of a page will be merged into one
page horizontally.

Front
Side :
...................... Front : Rear
side i Side
Rear :
Side
Merge Vertically Merge Horizontally

Note the options vary based on type of
scanner.
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Color
Matching

The purpose of Color Matching is getting the
accurate color. This option uses the default
parameters (ICC profile) to adjust the colors
of the image.

Choice: None, Document, Photo

e None: Choose “None” to disable this
option.

e Document: Choose “Document” if your
original contains pure text or a mixture of
text and graphic since it is an optimal
setting for regular business document.

e Photo: Choose “Photo” if your original
contains photo to reproduce your photo
in vivid color image.

.

After Color Matching
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4.3.3 Scanning color images

The following options are available for scanning color images.

. Brightness

. Contrast
. Resolution
. Invert

4.3.4 Scanning grayscale images

The following options are available for scanning gray images.

. Brightness

. Contrast
. Resolution
. Invert

4.3.5 Scanning B&W images

The following options are available for scanning B&W images.

. Binarization (Dynamic Threshold)
. Resolution
. Invert
Or
. Binarization (Fix Processing)

. Threshold

. Brightness
. Resolution
. Invert
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4.3.6 Editing Profiles

The Scanner Properties dialog box allows you to change and
save your frequently used scan settings into a profile. You can
edit these profiles by renaming or deleting them.

To add a new profile,

1.

Customize your settings. (For example, change your
resolution, image type, cropping method, scan size, or
other scan settings.)

Click the Image tab and then choose “Profiles” to prompt
the “Edit Your Profile” dialog box.

Click “Add” to enter the name of the profile and then
choose “Save”.

Add A New Profile

Flease enter the name of the profile:

[ Save ][ Cancel ]

The new profile will be saved and shown in the “Profiles”
dropdown list box.
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To load a profile,

1. From the Image tab dialog box, choose your favorable
profile from the “Profiles” dropdown list box.

Edit Your Profile

Profile: Add J [ peete |

Rename... ] [ Resat ]

5] dpi
Duplex, Gray, 200 dpi
Simplew, BidW, 200 dpi
Simplex, Color, 200 dpi

Simplex, Gray, 200 dp

2. Your favorable profile will be immediately loaded and
displayed on Scanner Properties dialog box.
To delete a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile E”E‘ El

Profile

Rename Resst

2. Choose the profile you want to delete from the dropdown
list box.

3. Click “Delete”. A Confirm message “Are you sure you
want to delete this profile?” is prompted.

4. Choose “Yes” to delete or “Cancel” to quit.
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To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.
Edit Your Profile
Frofils: [Betsy =] Add Delste
[ Betsy ]
?x?;;iix-B&W, 200dp1 M w
Simplex - Color, 200dpi
Simplex - Gray, 200dpi
Ext
2. Choose the profile you want to rename from the dropdown
list box and then click the Rename button.
3. Enter new name for the profile.
Rename a Profile gl
Pleaze enter the new name of the profile:
Original Neme: | Betsy
Wew Wame: |
Canrel |
4. Choose “Save” to save the new profile or “Cancel” to quit.
Note:

The preset default profiles include Flatbed, Simplex-B&W, 200
dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-
B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi. If
you have a simplex or a sheetfed scanner, the duplex or the
flatbed option will not be available.
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4.4 The Compression Tab

The Compression tab allows you to compress your scanned
image and choose the level of compression. Bi-tonal images
are normally compressed using CCITT standard called Group 4
(G4). Color and grayscale images are often compressed using
JPEG technology. Move the JPEG Quality slider to the right or
left to increase or decrease the level of compression. Note the
greater the compression level, the lower image quality. Default
is 50%.

Note that the compression depends on your image editing
application. If your image editing application does not support
the type of compression format, then either a warning
message will appear or the image quality of the compressed file
will not be acceptable.

JPEG (Joint Photographic Editor Group). This group developed
and lent their name to a file compression standard for color and
grayscale images that is widely used by scanners, and software
applications. On Microsoft Windows-based systems, a file with
the extension .jpg has normally been compressed using this
standard.

For scanning color or gray images, the following compressions
are available:

. None

. JPEG

For scanning B&W images, the following compressions are
available:

. None

. G4
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& Scanner Properties fgl

Image | Compression | Paper H Setting ” \nlurmaliunl

O @ Compressior:

O o Ao et
T —
T —
T A—

The Compression tab dialog box
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4.5 The Color Dropout Tab

4.5.1 Color Dropout Selection

The [Color Dropout] tab allows you to select either green,
red, blue, or a color of your choice to remove the details of the
selected color from a scanned image. This feature is used to
sharpen your text when using OCR (Optical Character
Recognition) software. Note this feature applies only to the
gray or black and white image.

Choice: None, Auto, Remove Red, Remove Green,
Remove Blue, Custom

- None: Does not remove any color.

Auto: Automatically outputs the image with the details of
the primary color removed.

Remove Red/Remove Green/Remove Blue: Outputs
the image with the details of the specified color removed.
Custom: Specify the color you wish to remove by entering
its RGB (Red, Green, and Blue) value respectively.

Advanced Options:

- Quality Mode: Range: 0—20. Default: 10
When [Quality Mode] is selected, you can determine the
color to be dropped out using the [Filter Threshold] slider. A
lower value will drop more of the selected color out, while a
higher value will leave more of the selected color in.

- Normal Mode: Use an optimized setting to determine the
color.
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a1 _30 days after
(FIRST OF THE SAME { N E (FIRST OF THE SAME TEN@R Al

LAY
FaW ! esuvmor
» |

THE SUM OF

Original Auto/Remove Green
(normal mode)

at_30 daycafter  sionr w1 _3o_dayg after SIGHT
(FIRST OF THE SAME TENOR AND DATE (FIRST OF THE SAME TH
Hsinchu Internatio

THE SUM OF THE SUM OF

Remove Red (normal mode) | Remove Green (quality
mode: Threshold: 18)

Preview the color dropout result:

To preview the color dropout result, please follow these steps:

1. Click the [Scanner Properties] icon ) on the upper
left corner, and choose [Tab] to show available tab
names.

Choose [Preview] to show the Preview tab.
Click the [Preview] tab to show the Preview page.

Load your document to the scanner and click the
[Preview] button to get a preview image.

5. On the [Image] tab, click [Gray] or [Black and White]
image mode and then choose [Custom] on the [Color
Dropout] tab. A [Preview window] button will be
displayed.

6. Click the [Preview window] button to prompt the
[Preview] window with the previewed image.
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Move your cursor over the preview image. Your mouse
cursor now becomes an Eyedropper.

Click to select a color which you wish to remove.

Click and hold your mouse button to view the result
after removing the specified color. If the result is
satisfactory, click [OK] to close the Preview window.

D1 3 3 48 8 T omow oW
L e s e R

- Pievew Fend | [
e O3G: 114,007 2

- [ Previews Figak [ ar
P 7400 110.B: 78 Corcel |

The Preview Window The Color dropout result
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£ Scanner Properties

Image | Color Dropout | Paper || Preview || Enhancement || Setling || Inlnrmatinn|

Front Auto Caolor D etection Calor Dropout:

Frant Calar [¥] Advanced Processing

Front Gray ]
[ [Front Biw

Fiegar Color

[ |Rear Gray
[] |Rear Baw

Rear Auto Color Detection l:l

]

The Color Dropout dialog box
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To select a color on the Color palette,

1. Click the Color
Dropout tab from
the Scanner
Properties dialog
box.

2. Choose Gray or
B&W from the
Image Selection
box and click
“Custom” from
the Color Dropout
drop-down menu.
The Color palette
appears.

& Scanner Properties

Colos Dioget |[Papes | Sisling | Inkousmston

Cobon Dot

O [Frentuy )
(=] [Fronnwe |

(] [Rem Gray
[ [fees Baw ]

& Seanner Properties
Image | Cotor Drepout | Paper | Seting | Infomation

Coker Droummnd.

Dl e ] Tosisnce:

Red:
Gieen
Bhe

[ [es e

[ Urlds ]

i3

J [ comen ]

4-33




User’s Manual

4.

Move your cursor
over the palette.
The cursor
becomes a cross
sign.

& Scanner Properties

emage | Ckor Diopout | Pages | Sty | Indosmaton

Con Drogmndt.

O] [Foor Gray Tekerance

Fied
Gostre.
B

S rrr—
0] Femgiw ] .

]
ET
10 & >
Ll
180) 2
il

Click to choose a color. The RGB values are changed

simultaneously.
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4.6 The Paper Tab

The Paper tab allows you to define values relating to image

output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed
Detection).

& Scanner Properties E|
Image | Colar Dmpoutl Paper | Preview | Setting | Information
Cropping. A =
[ Carier Shest Mode
(%) Partrait Landscape
Adjustment: Left: oon s Top: =
Fiight 000/~ Eottom =
Background Setting ‘W’hile Background v ‘
Uit ‘ Inches B ‘
Feeding
Transport Timeout: < | | 0Seconds
ot [ o

The Paper tab dialog box
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4.6.1 Cropping

Cropping allows you to capture a portion of the document
being scanned. Choice: Automatic, Automatic (36”),
Fixed to Transport, EOP (End of Page) Detection,
Automatic Multiple, Relative to Documents.

Options Description

Automatic Automatic adjusts the cropping window
according to different document sizes and
automatically straighten a skewed
document. Use this option for batches of
mixed-sized documents.

Automatic Automatically adjusts the cropping window
(367) according to different document sizes
smaller than 36” and automatically
straighten a skewed image. Use this option
for batches of mixed-sized document.

Note: The availability of this feature
varies due to scanner model.

Fixed to This feature allows you to define the area
Transport or zone to be imaged. Use for batches of
same-sized documents. If you select this
option, you can use the arrow keys to
define the x and y offset values, width and
length to redefine your scanned area. The
Display window will show image placement
as you change the values.

EOP (End of | This feature allows you to define the area
Page) or zone to be imaged. Use for batches of
Detection same-width but different length
documents. If you select this option, you
can use the arrow keys to define the x and
y offset values, width and length to
redefine your scanned area. The Display
window will show image placement as you
change the values.
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Automatic This option allows you to place various
Multiple sized documents such as photos, ID Cards,
or business cards on the flatbed (if
available) and lets you create multiple
individually cropped images in one scan.
Note: To correctly create multiple images,
please make sure there is at least 12mm
(0.5™) of space between each document.

Relative to This option allows you to crop different
Document areas on your documents and deliver these
images in B&W, Gray, or Color separately.
For example, there are applications which
require you to store the entire document in
B&W and a part of the document in color to
save storage space. This is useful for
documents where a photograph or
signature appears in a consistent area on
the document such as resumes, and so on.

The following options are only available when Fixed to
Transport is selected.

X-Offset — the distance from the left end of the
scanner to the left edge of the scanning area.

Y-Offset — the position from the top end of the
document to the top end of the scanning area.

Width — the width of the scanning area.
Length — the length of the scanning area.

Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected.

j_‘ — relocate the scan area by click the arrow key on
the cross sign while retain the scan size. View the result
from the Display window.
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Relative to Document: (used for batches of same-sized
documents)

This option allows you to crop different areas on your
documents and deliver these images in B&W, Gray, or Color
separately. For example, there are applications which require
you to store the entire document in B&W and a part of the
document in color to save storage space. This is useful for
documents where a photograph or signature appears in a
consistent area on the document such as resumes, and so on.

The following procedure describes how to reproduce the entire
document in B&W and a portion of document (picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed
to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The
selected scan size will be displayed in a red rectangular
box. This is also the scan size of your entire document.
(For example, 1SO B5. If you have not chosen a scan area
and leave the selection as None, then the default area will
be the scanner’s maximum.)

& Scanner Properties =

knage | Paper | Préviens | Setting | Infomation

[] [Foent Ao Color Detection | LI
T —— o il
[ [Feork Gray ) 14
Pl r— :4
[) [P s ColerDotecien ) N
[ e Cokoe o3 44
Blr—— .3 — Ared
O] [ResBiw ] E

R °3 rectangular
Scandien 7=
Wra g || o3 box

&) Patid =

E .
E. o
E o
E

0Nl 0gl

f-Oifset —ad
i mm

Lersgth LLS

une CET—

[ Setecind sma sppbes b all e

Defats Peview | [0k | [ Cecel |
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3. Click the Preview tab to display the Preview window. A
black rectangular box appears to indicate the max. scan
size your have just selected.

The Image —
Selection
Box
— A black
. rectangular
e * box

4. Click the Preview button to view the entire image in low
resolution to correctly crop your relative scan area.

The Preview
Image

The Preview
Button

5. Select image type from the Image Selection box. The
selected image will appear in highlighted color. (For
example, Front Color)

6. Place your cursor on the Preview window and click your
left mouse button. A cross sign will appear as illustrated.
Create your relative scan size diagonally by dragging the
left mouse button to your preferable size. The selected
area will appear in a red box as illustrated.
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A Cross
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Relative
Area

Check the B&W image from the Image Selection box to

scan the entire document.

Click the Scan button to start scanning the document in
two image types and sizes. (See the result in below.)
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4.6.2 Other Paper Selection

Carrier Sheet Mode:

Check this option to automatically crop the scan window
according to your document size when scanning non-standard
document (fragile, irregular-size document) with a carrier sheet
(optional). Note: The availability of this option varies due to
scanner model.

Loading Documents Using a Carrier Sheet

A Carrier Sheet is a plastic sheet specifically used for loading
non-standard document onto the scanner. It allows you to scan
document that can not be scanned in the regular way. Also,
documents larger than A4 size, such as A3 and B4, can be
scanned by folding in half, inserting into the Carrier Sheet, and
scanning in duplex mode. You can also scan documents that
can be damaged quite easily such as photographs, or irregular
size documents that are difficult to load directly such as

clippings.
To scan document using a Carrier Sheet,

For documents larger than A4/Letter size, such as A3

a. Fold the sheet to be scanned in half.
b. Fold the sheet tightly and smooth out crease. Otherwise,
the sheet may be skewed during scanning.

JIliE

JI

! [
1

! !
! 1
! I
! I
¢ I
! ]
l

i i
| 1
' !
! I

1. Open the Carrier Sheet and place the document
inside.
Align the top of the document to the top of the Carrier
Sheet (the printed area).
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For documents larger than A4/letter size, such as
A3

Align the top of the document to the top of the Carrier
Sheet (the printed section) and the folded portion to the
right edge of the Carrier Sheet so that the document fits
into the Carrier Sheet at the upper corner.

For non-standard document
Center your document in the Carrier Sheet.

Load the Carrier Sheet with the gray section (printed
section) facing downwards.

Adjust the paper guides to the width of the Carrier Sheet.
Adjust the paper guides so that there is no space
between the guides and the Carrier sheet. Space between
the guides and Carrier Sheet may cause the Carrier Sheet
to become unaligned during scanning, and skew the
scanned image.

Start the scan.
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Notice:

e [Carrier Sheet] is available for the models that support the
Carrier Sheet.

e Some functions are disabled when [Carrier Sheet] is
checked.

e This option may not work properly on some applications.

Scan Area

Choose your desired paper size with the drop-down list box. Or
you may select a custom paper size by clicking the Scan Area
box and then click Add to include in the choice.

Choices are listed below:

None
US Letter- 8.57x 11~

US Legal — 8.5” x 14~
ISO A4 — 21 x 29.7 cm
ISO A5 —-14.8 x 21 cm
ISO A6 — 10.5 x 14.8cm
ISO A7 — 7.4 x 10/5 cm
ISOB5 —-17.6 x 25 cm
ISOB6 —12.5 x 17.6 cm
ISOB7 —8.8x12.5cm
JISB5 —18.2 x 25.7 cm
JISB6 —-12.8 x18.2 cm
JISB7 —9.1 x12.8 cm
Scanner Maximum
Long Page (<118”)
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Long Page (<118”):

When you need to scan documents whose length exceeds
scanner maximum, please choose Long Page. Note if Long
Page is selected, the Multi-Feed Detection will not be
available. (Note: This option and the maximum allowable
document length vary due to type of scanner.)

When Long Page (<118”) is selected, be sure to specify your
document size in the Length and Width field.

Notice when scanning long page document:

1. Pull out the extension in the ADF Paper Tray.

2. Secure enough space around the Output Tray to prevent
the ejected paper from falling off the Output Tray.

3. To ensure the performance, in color mode, set the
resolution to be 300 dpi or lower; in Black and White
mode, set the resolution to be 600 dpi or lower.

4. Depending on your system environments, application, or
your specified paper size, there may be insufficient
memory to perform scanning.

OverScan

Overscan allows you to add a specific margin at top and bottom
or right and left (Options vary based on the type of scanner) of
the edge of the image. This is used to reduce possible corner
clipping on the skewed images and often applied to a batch of
skewed document to be scanned in the auto document feeder.
Select a value ranging from 0 to +5 mm for Top/Bottom and O
to 2.8 mm for Left/Right. Note the overscan result will not be
shown in the Display window and that the availability of the
function and selectable range vary based on type of scanner.
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Adjustment

When “Automatic” is selected in the [Cropping] option, the
OverScan option will be replaced by the Adjustment option.
With the Adjustment option, you can specify the scanned
image to be slightly extended or cut from the edge of original
document if a positive or negative number has been specified.

Top/Bottom/Left/Right: Specify the range to be slightly
extended or cut from the top/bottom/left/right edge of
document. Available range: from -1 inch to +1 inch.

<+ (range): -17 — +1 “

7Y
v
y

: original document

Pre-Feed

Choice: Enable, Disable. If enable is selected, you can set the
amount of time the scanner starts pre-feeding your paper after
your documents has been loaded into the feeder. The default is
disable. Note: The availability of this option varies due to
scanner model.
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Transport Timeout

Set the amount of time the scanner will wait and then start
auto scan after the first scan job is completed. If you have
many separate documents need to be scanned at the same
scan settings, this feature is especially useful. The default is O.
The value ranges from 0 to 30 seconds.

Note:

1 Within the specified timeout period, if you load your
document to the feeder, the scanner starts scanning
automatically.

2 If your scanner has a flatbed option and you place your
paper on the flatbed, after the timeout period, you need
to click the Scan button on the TWAIN user interface to
start scanning.
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Background This option allows you to set your scan
Setting background. Choice: White Background,
Black Background.

Note: For a sheet-fed scanner with an auto
document feeder, this option is currently
available only in the “Auto crop” mode. For a
scanner with a flatbed platen, this option is
available either in the “Auto crop” or the
“Fixed to Transport” mode.

3 N
White Background

S
Black Background
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4.7 The Multi-Feed Detection Tab

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document
that go through the auto document feeder. Multi-Feed usually
occurs due to stapled documents, adhesives on documents, or
electro-statically charged document. Note : The availability of
the function varies based on type of scanner.

l;', Scanner, Properties E‘

Image | Paper | MultiFesd Detection | Setting | Information
Multi-Feed Detection
[ &dditional Length Detection:
[ Ulrasonic Detection

4

Unit: Inches v
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Additional Length Detection

Additional Length Detection allows you to define the length of
document being multi-fed. This value indicates the additional
length exceeding your scan area. The Display window will
show the size of the document as you change the value. A
value of O indicates no additional length detection. The
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.

Ultrasonic Detection

Ultrasonic Detection allows you to set overlapped document by
detecting paper thickness between documents. Note : The
availability of the function varies based on type of scanner.

There are two options available if Multi-Feed is detected.

e Stop Scanning after Multi-Feed

If this is selected, the scanner will stop the feeder and
display the following Warning dialog box if multi-feed is
detected.

| E Multiteed iz detected, please remnove the rest paper from ADF.
-

Action:

1. Follow the instruction on the Warning dialog box to
remove the rest pages on the feeder.

2. Click OK to close the Warning dialog box.
3. Scan the rest pages.
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Clear the Multi-Fed Paper: Auto

If this is checked, once multi-feed is detected and scanning
operation is stopped, the scanner will automatically clear the
transport of the multi-fed paper. If this is not checked, once
multi-feed is detected and scanning operation is stopped, you
need to manually clear the transport of the multi-fed paper.
Note: The availability of this option varies based on type of
scanner.

e Multi-Feed Alarm

If a wave file is added, the scanner will make a sound
alarm if multi-feed is detected yet no Warning dialog box
will be displayed.

If “Stop Scanning after Multi-Feed” is selected, the scanner
will stop the feeder.

If “Stop Scanning after Multi-Feed” has not been selected,
the scanner will continue to scan till the end of your
document.

Action:

1. If “Stop Scanning after Multi-Feed” is selected, follow
the action described in the preceding section “Stop
Scanning after Multi-Feed” on the previous page to
complete your job.

2. If “Stop Scanning after Multi-Feed” has not been
selected, rescan the pages where multi-feed is
detected.
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How to add the sound alarm :

1. Click the Browse button on the right side of the speaker
icon. The Open dialog box appears.

2. Choose your wave file.
3. Click the Open button. The wave file is added.

Units

Defines the primary measurement system. Inches,
Millimeters, and Pixels are available.
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4.8 The Preview Tab

The Preview tab allows you to preview (a low-resolution scan)
your image before final scan. This preview image lets you
allocate your scan area. You can choose your scan area by the
“Scan Area” drop down list box or placing your cursor on the
Display window and dragging it diagonally on the Display
window. Then, a red rectangle box will appear to indicate the
selected area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”,
then to select a scan area on the Preview tab is not allowed.

& Scanner Properties

(X

Image | Color Dropout | Paper | Preview | Enhancement | Setting | Information

] |Front Auto Color Detection
] {[Front Color /
G tonk Gray

ront BEW

jear Auto Color Detection

eat Color

H

1 2 3 4 5 B8 7 8 0

I

AEEEREEE

The Display
Window

et Gray
eal BEW

Scan Arex

Moy

&
<

® Portrait

HeOffzat on
¥-Olfget 0.00
Width 8%

4r 42 1) 42

Length: 11.69
Uit Inches v/
] Selectad area apphes 1o all modes

Dedfaults Preview | [ ok ][ Cancal

The Preview Tab
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4.9 The Enhancement Tab

The Enhancement tab allows you to set following additional

image processing settings.

% Scanner Pro perties

Image | Color Dropout | Paper Prewawl Enhancementlsettmg Infarmation

X

Funch Hole Removal

[[] Punch Hole Remaval

Background Setting

None w

Background Processing:

Edoe Fill

@) \white [ Edge Extend

O Black [ 0] Milimeters
Diezpeckle

[ 4
1

0K

] [ Cancel

[

The Option tab dialog box
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Punch You can remove punch holes from the output

Hole scanned image when scanning punched document.

Removal Note the availability of this feature varies
depending on your scanner model.

Original Output image

Punch holes can not be removed when:

¢ Resolution is set lower than 150dpi

e The hole is near the edge of the document

e The holes are not aligned along the edge of the
document

e Punch Hole Removal is available only when
“Auto Crop” is enabled. If either “Fixed to
Transport”, “EOP (End of Page) Detection”,
“Automatic Multiple”, “Relative to Documents” is
selected from the Cropping option on the Paper
tab, the Punch Hole Removal option will be
disabled.
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Background Processing: The [Background Processing]

option allows you to smooth background color or remove it to

make image clearer. The option is especially useful for

documents with color forms such as invoices.

Choices: None (default), Smooth, Removal

- None - no background processing will be performed
(default)

- Smooth - produces images with a more uniform
background color. This option improves image quality.

- Removal - identifies the background color and then
removes it.

Sensitivity: Choice: 0, 1, 2, 3, 4. Default: O
- The higher the value, the more background color will be
kept.

Mode: Auto, Moiré

If [Smooth] is selected in the [Background Processing]

option, then the choices for the [Mode] option includes Auto,

and Moiré.

- Auto - uses the factory preprogrammed mode to proceed
background smoothing.

- Moiré — Remove the moiré patterns that appear on the
background of the image when scanning printed material.

If [Removal] is selected in the [Background Processing]

option, then the [Mode] option will be replaced with [Fill

Color]. Choices: White, Auto.

- White - identifies the background color and substitutes it
with white.

- Auto - identifies the background color and substitutes it
with the color of the largest background zone.
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Edge Check White or Black if you wish to add white or
Fill black edge on the border of your scanned image.
Enter the value from 0 to 5 mm. Default value is O.

Original Edge Fill: 5mm (Black)
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Despeckle

Occasionally small dots or specks appear in the background of
a scanned image. Remove unwanted speckles provides a
cleaner image for OCR (Optical Character Recognition)
processing, and also helps to reduce compressed file size.

Define the speckles (also known as image noise) you wish to
remove by specifying its number (size) and radius (range). The
measuring unit is pixel. The higher the number, the more
speckles will be removed.

t‘;%plague on thee! Hast thou
never an eye in thy head? Canst
not hear? .
—The First Part of King Henry the Fourth:
2.1.26-27

A carrier to Gadshill, the host of a tavern.

Before Despeckle
(noise number:0, noise radius:1)

%plague on thee! Hast thou
never an eye in thy head? Canst
not hear?
—The First Part of King Henry the Fourth:
2.1.26-27

A carrier to Gadshill, the host of a tavern.

After Despeckle
(noise number:22, noise radius:10)

Note:

. The function is currently available for Black and White
image only.

. To scan at rated speed, it is recommended to set the
noise radius up to 10 pixels.
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4.10 The Rotation Tab

The Rotation tab allows you to set the following image rotating
options:

& Scanner Pro perties E|

| Image || Paper | Fiatation | Setting | Information |

Fotation

Rotation Degrees :

Image Contral Options

Flip Side Rotation

Book Fanfald

Image Contral Optians

[ irrar

o) [_coce
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Rotate
Image

Choose the rotation angle from the drop down
list if you wish to rotate your scanned image.

Choice: None, 90°CW/(clockwise),
90°CCW((counter clockwise), 180°, Auto
based on contents. Auto rotate every
even page.

123 -

(\®)
J
Original Rotate 90°CW
N
< €T 1
—
Rotate 90°CCW Rotate 180°

Auto based on contents: When Auto
based on contents is selected, images can
be rotated to their proper orientations based
on their contents.

Auto rotate every even page:
Automatically rotate 180° on every even
page. This is especially useful when you scan
the inside pages from a book. As a result, if
you choose “Flatbed (book)” from the “Scan
Source” option, “auto rotate every even page”
will be selected as default.

Note: This option varies based on type of
scanner.
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Split
Image

By splitting an image, two separate images are
created horizontally or vertically. This is useful
for documents containing two pages per image
when you want to save them as two images
(one page for one image). Choice: None,
Horizontal, Vertical. Default is None.

Horizontal: Divide one image into the upper
half and the lower half.

Vertical: Divide one image into the left half and
the right half.

£ Jer

Split Horizontally Split Vertical
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Flip Side Select “fanfold” to rotate the image of the
Rotation reverse side to 180 degrees.

This is applied to double-sided document
which are viewed in portrait are sometime
fed into the scanner in landscape or vice
versa.

Choice: Book, Fanfold.

If “Book” is selected, the image of the
reverse side will not be rotated.

The following illustration shows the documents which should
be viewed in portrait are fed into the scanner in landscape

|
|
2
=
: 228 = W
K 3= N
§ a8 =
L [ S B
3 i / HEE =
H g _w 1]
: v ) 8
28 s / 58 B
i {4 2z
F » : B
s
/ )
{ B8
?r“:
[+
a.
88
.iﬁ
H
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Image  Check the Mirror box if you wish to reverse the right
Control and left side of your image.
Option

W

o
The Mirror Effect
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4.11 The Separation Tab

The Separation tab allows you to enable the detection engine to
detect the blank page, barcode, and patch code and then notify
the software application which supports document separation
to separate your multi-page documents. Choices: Blank Page
Removal, Barcode Detection, Patch Code Detection.

(X

# Scanner Properties

Image | Paper | Rotation SEllﬂlﬂlim|Settimg Information

Blank Page Removal

[[] Blank Page Remaoval Threshold:

Barcode Detection

[JEnable

Patch code Detection

[ Enable

o [ cwes

Blank Page Check if you wish to remove the blank page
Removal and move the slider to the left or right to your
desired threshold.

When the bar code has been detected successfully - a file
[avbarcode.ini] will be created and stored in the following path:

4-64



User’s Manual

Windows XP: C:\Documents and Settings\All Users\Application
Data\%PRODUCTNAME%6

Vista, Windows 7, Windows 8:
C:\ProgrambData\%PRODUCTNAME%

Barcode Detection:

Check [Enable] to detect barcode and notify the software
application for advanced processing. Please note the whole
document will be checked and no specific detection area needs
to be designated.

Click the [Select Barcode Types] button to select the barcode
types you wish to detect.

Barcode Types:
The following barcode types can be detected.

One-dimensional barcodes:
Code 39

Code 93

Code 128

EAN-8

EAN-13

ITF (Interleaved 2 of 5)

UPC-A

Codabar

GS1 DataBar (formerly RSS-14)

Two-dimensional codes

Aztec

DataMatrix

MaxiCode

QR Code

PDF417 (MicroPDF417 not supported)
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Note:

° Recommended resolution: 200~600 dpi for regular
barcode, 300~600 dpi for QR code

° Skewed barcodes may not be recognized correctly.

° Using the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the sheets.
If the sheet is not recognized correctly or gets smudged,
replace it with a new sheet.

Patch code Detection:
Check [Enable] to detect patch codes and notify the software
application for advanced processing.

A patch code is a pattern of parallel, alternating black bars and
spaces (i.e. a barcode) that is printed on a document. Patch
code sheet is most commonly used as a document separator in
a stack of document.

You can find various sizes of patch codes (PDF) by choosing
[Start] menu=>[All Programs]>[Avision Scanner
Series]>[Patch code] in succession.

Simply print the PDF file to produce the patch code sheet.
Insert the patch code sheets to wherever you want the file to
separate.

Patch code sheet
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Notes to print the patch codes:

Use blank white paper.

Set the scaling to 100%. The sheet is not recognized
correctly when printed in a size smaller than the original.

Do not use toner saving mode. The sheet is not recognized
correctly when the print is too light.

Do not use thin paper in order to avoid bleed-through from
the back.

When you copy a patch code sheet that you printed out,
make sure to copy by the same size and brightness as the
original copy.

Use the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the sheets.
If the sheet is not recognized correctly or gets smudged,
replace it with a new sheet.
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4.12 The Setting Tab

The Setting tab allows you to set the following settings:

& Scanner Properties EJ
Image | Color Diopout | Paper | Freview | Enhancement | Setting | Information
Cache
Mode Memory Size -
Memory Size: < 3| Defaul
Energy Saving Contol
Enable Energy Saver L3 ¥ 15 minutes
3
BE] [ Enable Power Of < 3 240 minutes
Shaw Scarning Progress Tabs
[Compression
v
Show Warning Message 2ol Dropont
[CIMulti-Feed Detection
[Preview
[IRotation
[1Separation
[Enhancement
[limprinter

The Setting tab dialog box

Energy Saving
Control

Check the Enable Energy Saver box
and move the slider to set the amount
of time to start the energy saver after
your last action. The range is from 1 to
242 minutes. The default value is 15
minutes.

Enable Power
Off

Check the Enable Power Off box and
move the slider to set the amount of
time to automatically turn off the
scanner after your last action. The
range is from 1 to 480 minutes. The
default is 242 minutes (4 hours). Note
the value of “Power Off” has to be
greater than or equal to the value of
“Energy Saving”.

4-68




User’s Manual

Cache Mode: None, Page Number, Memory
Size.

This option allows you to assign a specified
memory size from the available RAM to
process the image data. By specifying a
smaller memory size, you can free more
memory for other applications you are
running. By specifying a larger memory
size, you can have more memory to
process the image data especially when you
have a large amount of documents needed
to be scanned.

You can also specify your memory size by
the page number. For your information, an
A4 color document scanning at 300 dpi
consumes approximates 24MB.

Image Count

When the selected cache mode is “none”,
the image count option allows you to assign
number of pages you need to scan. For
example, if you wish to scan the first two
pages, simply move the page slider to 2,
and the scan action will be stopped when
the scanning of the first two pages have
been completed.
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Show Scanning | Check and the scanning progress bar
Progress will be shown during scanning.

Show Warning | Check to show the warning messages
Message such as “ADF pad count exceeds
50,000 scans (the number varies based
on type of scanner). Please replace the
ADF pad and reset the pad count.”

Save Settings Check to save your scanner properties
after Closing settings after leaving the dialog box.
Next time when you open the Scanner
Properties dialog box, the previously
saved settings will be shown.
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4.13 The Imprinter Tab

The Imprinter tab allows you to print alphanumeric characters,
date, time, document count and custom message on your
scanned image if digital imprinter is selected or at the back of
your document if external imprinter is selected.

& Scanner Properties g|
Image | Color Dropout | Paper || Preview | Enhancement | Setting | Imprinter | Infomation

Digital Imprinter

Content
Frint &Il

Custorn:
Counter. 0o ﬂ D ate/Time: None 4 ﬂ

Custom Font: Normal v

Advanced Fririt Position
Font Attributes: Naormal v Positior: Middle v

Sting Orientation: Marmal »

Sample
noot

Choice: External Imprinter, Digital Imprinter. If you have
installed an external imprinter, choose external imprinter. If
you do not have an imprinter, choose digital imprinter. Note
External Imprinter provides a vertical and rear-side print
capability while digital printer provides a horizontal and front-
side print capability.
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Contents

Print All Check Print All to automatically print the
text at all pages of your documents.
Uncheck Print All to print the text for the
first page of your documents only.

Custom Enter your custom text to be included in your
print string.

Counter Show the document count for the scan

session. This value is increased sequentially
by the scanner.

Date/Time | Choose if you wish to include the date and
time in your print string.

Format: YYYYMMDDHHSS For example,
20090402170645-check0001 indicates year,
month, date, hour, seconds, your custom
text and the counter.

Custom Choose your desired font.

Font Choice: Normal, Fixed Width

Fixed Width (Mono spaced) fonts have a
fixed character spacing. So each character
occupies the same width.

Advanced
Font Choose your font attributes. Choice:
Attributes Normal, Underline, Double, and Bold.

4-72



User’s Manual

String Choose your string orientation.
Orientation | Choice: Normal, Rotated, Vertical,
Vertical Inversion, 90 degrees CW, 90
degrees CCW

2qeQLoc
2010abc

Normal Rotated

oD OoO—=0M
NO—0O @O

Vertical Vertical Inversion

2qeQ10¢
2010abc

90 degrees CW

90 degrees CCW

If you check the digital imprinter to stamp
text on your scanned image, the illustration of
normal and rotated string is shown below:

2010abc 9qegloc
Rotated

Normal
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Print Choose the position you wish to print your
Position string. Move the slider to the right to increase
the value or to the left to decrease the value.
Range: 0—355mm, default:0 mm

The value indicates the height from the
bottom of your paper to the last letter of your
string. This option is available only if an
external imprinter is installed.

0T0Z 929eT000

| The value of
Print Position

|

Print Position (for digital imprinter)

Choose the position of your printed string. Choice: Top,
Middle, Bottom, Custom. If Custom is selected, enter the X
and Y offset value to specify the position.

4-74



User’s Manual

4.14 The Information Tab

The Information tab displays the following system and scanner

information.

& Scanner Pro perties

CPU

RAM:

0s

05 Language:
Disk Drive:

Free Dizk Space;

Application Mame;
Tw/AIN Driver Yersion:
140 Drriver Mersion:
Port Type:

ID / Address:

Optical Resolution:

Scanner Model

Serial Mumber:
F s Version:

Image | Color Diopout | Paper | Preview | Enhancement | Setting | Imprinter | Information

IntellR] CorefThi) i3-2120 CPU & 3.30GHz
1023 ME
Microzoft Windows =P Service Pack 3 [Build 2600]
English [United States]
Fired dive C:\Total 20465MBFree:14113MB
Fixed drive 4T otak102398MB Free:8122MB
14119 MB

Ayision Capture Tool 1.6(1.9)
6.00.062014

0.9, 2014, 528

use

USE

600 dpi

aDze0
AL

Cancel

The Information tab dialog box

The “Report” button :

If you encounter any error message while using the scanner,
click the Report button. A report.txt file [Windows XP:

C:\Documents and Settings\All Users\Application

Data\%PRODUCTNAME%b; Vista, Windows 7, Windows 8:
C:\ProgramData\%PRODUCTNAME%b (C: system drive)] will be
generated. Please send this file to the nearest service center

for trouble shooting.
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5. Using the Buttons

5.1 Installing Button Manager V2

Button Manager V2 provides you an easy way to scan your
document and then link the scanned image to your designated
software application. All this can be done by a simple touch of
the button on the scanner. Yet, before you scan, it is
recommended to check the button configurations first to ensure
a proper file format and a destination application.

52 Checking the Button Configurations Before
Scanning

1. Button Manager V2 runs from the system tray. After Button
Manager V2 and the scanner driver are properly installed,
Button Manager V2 is started and the Button icon will be
displayed in the system tray.

The Button vy 01:41 P
Icon

)%=

2. Left-click the Button Manager V2 icon to prompt the
following Button Panel.

; This indicates the scanner model

L

——

i

iSecan (Image)

E-hail

v 1T

y Frre The Function
Y Icon

]

—

X

[Scan (OCR)

&

Sean To App —

|

!i!EIi!E!!

o
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Basic Scan
Parameters

The Button Panel shows the first three scanning buttons.
Right-click the button (function) you wish to check. The
Button Properties window appears.
Name of the Selected Button
Button Basic | Image Adinstment | Color Diopont || Image Processing | More Settings
Name — n iScan (Image) o
—— Resolution(dpil: 7] 200
mage Mode
Image. Mode IT[] ) Auto Paper Size: Luto Crop S Deskew £
Selection B OCer
Box O Otny :
[_j ) Blsck and Whits Advanced Settings: [ Use TWAIN
Folder and Elellocatinn
file name Directory: C\Documents and Settingsbvoid by Documentsibdy Pictores
for the Fils Name Image_#HEHTOCR Mare..
Isrfr:‘laar;réed File Format; TFEG A Froperties
Destination: 2 iSean v
ScanTo __ | Description: 5 licatio and insert the d i ditable et
destination S| e OCR) Bheely 1y applicaion.
and settings
OCR Language:  |{SfEH) w | ScanCount: 0
OCR OCE Zone Top w  Keywond Sample
settings )
Wo. of Recognized Characters After Eeyword: 5

If you wish to change the setting, use this window to reset

the setting for the file format, destination application, or
other scan settings. See “Configuring the Button” in the

subsequent section to reset the settings.

4.

Click the OK button to leave the window.

Note: If the Button Panel has not been displayed in the
Windows System Tray after restarting your computer, please

just turn off and on your scanner. The Button icon will then be
displayed on the Windows System Tray.
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5.3 Using the Buttons

Ce] s & )

iScan/Button #1 Print/Button #3

E-mail/Button #2
1. Press the button you desire.

iScan/Button #1:

Scan a document and insert the scanned image to your
application which is already launched and your mouse
cursor has just clicked.

E-mail/Button #2:
Scan a document and send the image from your default e-
mail software to an e-mail recipient as an attachment.

Print/Button #3:
Scan a document and print it from your default printer.

2. The status bar will display to indicate the progress of your
task.

Note:
For details information on how to use the Button Manager V2
V2, please refer to the user’s manual in the supplied CD.
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6. Maintenance

6.1 Cleaning the Glass

The procedures

1) Use a clean and lint-free cloth wet with isopropyl alcohol.
(95%)

2) Open the document cover as shown in Figure 6-1. Wipe the
document glass.

3) Close the document cover. Your scanner is now ready for
use.

Figure 6-1 Cleaning the Glass
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7. Troubleshooting

7.1 Questions and Answers

Question:

Why is it that the scanned image
always comes out to be too dark?

Answer:

1) Please adjust the screen settings to
SRGB.

2) Please adjust the brightness
settings on the screen from application
software.

Question:

When | choose optical resolution
to be 600 dpi, the "auto crop'™ and
"deskew functions will be
disabled.

Answer:

Since to perform auto crop and deskew
consumes great deal of system
memory, it is suggested if you wish to
perform "auto crop" and "deskew"
functions, please choose your optical
resolution to be smaller than 600 dpi
to prevent an error message.
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7.2 Technical Service

Before contacting Avision, please prepare the following
information by referring to Section 4.14, The Information Tab:

®  Scanner serial & revision number (located on the bottom of
the scanner);

= Hardware configuration (e.g., your host CPU type, RAM size,
free disk space, display card, interface card);
The name and version of your scanning software application;
The version of your scanner driver.

Please call us at:

Headquarter

Avision Inc.

No. 20, Creation Road I, Science-Based Industrial Park,
Hsinchu 300, Taiwan, ROC

TEL: +886 (3) 578-2388

FAX: +886 (3) 577-7017

E-MAIL: service@avision.com.tw

Web Site: http://www.avision.com.tw

US and Canada Area

Avision Labs, Inc.

6815 Mowry Ave., Newark CA 94560, USA
TEL: +1 (510) 739-2369

FAX: +1 (510) 739-6060

E-MAIL: support@avision-labs.com

Web Site: http://www.avision.com
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China Area

Hongcai Technology Limited

7A,N0.1010, Kaixuan Road, Shanghai 200052 P.R.C.
TEL :+86-21-62816680

FAX :+86-21-62818856

E-MAIL :sales@avision.net.cn

Web Site:http://www.avision.com.cn

Europe Area

Avision Europe GmbH

Bischofstr. 101 D-47809 Krefeld Germany
TEL: +49-2151-56981-40

FAX: +49-2151-56981-42

E-MAIL: info@avision-europe.com

Web Site: http://www.avision.de

Espaco Brasil

Avision Brasil Ltda.

Avenida Jabaquara, 2958 — Cj. 75 — Miranddpolis
S&o Paulo / SP

TEL: +55-11-2737-6062

E-MAIL: suporte@avision.com.br

Web Site: http://www.avision.com.br
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8. Specifications

All specifications are subject to change without notice. For the
most up-to-date and detailed specifications, please refer to our
web site at http://www.avision.com

Model Number FB1200+

Scanner Type Flatbed

Scanning Mode Color/Grey/Black & White
Optical Resolution 1200 dpi

Light Source LED

Maximum Scanning Size 216 x 297 mm (8.5 x 11.7 in.)
Interface High Speed USB 2.0

Power Requirement 12Vvdc » 1,25A

Power Consumption < 11 watts (operation)

< 6 watts (standby)
< 2.9 watts (sleep)

Humidity 10~85% RH
Operation Temperature 10°C —~ 35°C
Dimension (WxDxH) 260 x 410 x 43 mm
(10.2x10.1 x 1.7 in.)
Weight 1.5 kg (3.3 1b.)
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INndex

Additional Length Detection, 4-
51
alignment mark, 3-1
Auto Color Detection
sensitivity, 4-10
B&W, 4-9
Background Setting, 4-49
Binarization
Dynamic Threshold, Fixed
Processing, 4-12
Blank Page Removal, 4-68
Brightness, 4-18
Button Panel, 5-1
Button Properties window, 5-2
Cache
None, Page Number, Memory
Size, 4-73
Color, 4-9
Color Dropout
Remove Red, Remove Green,
Remove Blue, Custom, 4-
30
Color Matching, 4-23
Contrast, 4-18
Cropping
Automatic, Fix to Transport,
EOP Detection, 4-37
Custom Font
Normal, Fixed Width, 4-76
default settings, 4-3
Despeckle, 4-61
Noise Number, Noise Radius,
4-61
Document Type

Normal, Photo, Document, 4-
16Dynamic Threshold
sensitivity, 4-12
Edge Fill, 4-60
E-mail, 5-3
Enable Power Off, 4-72
Energy Saving, 4-72
Fixed Width, 4-76
Flip Side Rotation, 4-66
Font Attributes
Normal, Underline, Double,
Bold, 4-76
G4, 4-28
Gray, 4-9, 4-16
Invert, 4-20
iScan, 5-3
JPEG, 4-28
Mirror, 4-67
Multi-Feed Detection, 4-50
OverScan, 4-46
Print, 5-3
Print All, 4-76
Print Position, 4-78
Punch Hole Removal, 4-57
Resolution, 4-19
Rotate Image, 4-64
Scan Area, 4-45
Split Image
None, Horizontal, Vertical, 4-65
String Orientation
Normal, Rotated, Vertical,
Vertical Inversion, 90 deg
CW, 90 deg CCW, 4-77
Transport Timeout, 4-48
Ultrasonic Detection, 4-51
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